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M SID Monitor Overview

SID monitor is a utility for SID monitoring stations. It has been designed to automate as much as possible the data
acquisition and storage tasks, so that the user can focus on data analysis.
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SID monitor acquires digital data from a VLF receiver. Up to 16 channels can be monitored simultaneously.

Each channel signal level is periodically sampled and stored in a database. To that purpose, SID monitor embeds
RRDTool data logging and graphing application. All RRDTool low-level database management and graph generation
commands are automatically handled by SID monitor .

RRDTool also includes an aberrant behavior detection algorithm. This algorithm is used to warn the user of potential SID
detection. Warning messages can be sent by email.

Monthly snapshots of the database are done.

SID monitor also include help for generating monthly reports which format is compliant with the NGDC (National
Geophysical Data Center ) as required by the AAVSO (American Association of Variable Star Observers ) for reducing
data gathered by all VLF monitoring systems.

SID monitor automatically downloads the X-ray flux measurements from the GOES satellites. As a comparison means,
those values can be plotted on the signal level graphs.
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System Requirements

SID monitor is a .NET application written in Visual C#.
It has been compiled on Visual Studio C# 2005 Express Edition .
It consists of about 50,000 lines of code.

Hardware:

Basically, any PC can be used. Nominally, in data acquisition mode, CPU requirements are very low and memory usage is
about 14 Megs.

Note: Specific functions such as "Reapply New Algorithm Parameters" are very CPU and memory consuming. In this
case, a 2GHz CPU and 512Mb to 1Gb of RAM are welcome, depending of the number of channels being used.

Connection to the analog-to-digital converter (MAX187) is done through a serial (COM) port.
The software has also been tested on a USB-to-serial port converter.

Software:

SID monitor should run on any Windows platform running .NET 2.0. It has successfully been tested on Windows XP SP2
Home Edition, Windows XP SP2 Professional Edition and Windows Server 2003 SP1.

The following prerequisites are required:
m Microsoft .NET 2.0 Redistributable Package. You can download it here .
m RRDTool. Itis a data logging and graphing application. You can download it here .

Installation

SID monitor can be installed either manually by downloading binary archives, automatically through an installer or online.
Online installation is more intrusive to the system but is easier and it offers automatic updates functionality.

Manual Installation:

m [nstallRRDTool.
m Install NET Framework 2.0.
m Download SID monitor archive here . Extract it and copy it to any folder.

Automatic Installation:

» InstallRRDTool.
m Download SID monitor installer here and execute it. .NET Framework 2.0 will automatically be installed if necessary.

Online installation Installation:

» InstallRRDTool.
= Execute SID monitor online installation . .NET Framework 2.0 will automatically be installed if necessary.



After the installation, it is necessary to configure the application (paths to RRDTool and database folder, channels setup...).
Refer to Options menu for more information.
SID monitor uses the Windows registry only for the "Automatic start when user logs" option. The registry key that is

accessed is "HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Run". An "SID_monitor" entry is
added if automatic start is enabled.

Copyright (c) 2006-2011 Lionel Loudet
Home Page: http://sidstation.loudet.org/sidmonitor/
Support: lionel@loudet.org



Monitboxring Stattion

M Graphical User Interface

SID monitor main window consists of:
= amenu bar;
m a graph display area with zooming capabilities;
m adate pane, a channels pane and a GOES pane, selectables through tabs;
m amessage area ;
m a status bar .
The various panes are dockables and can be hidden to save space.

A notification icon is present in the windows system tray to indicate the application status. A menu is available by right-
clicking on this icon.

When the main window is minimized, if the "Minimize to Tray" option is set, no tab is present in the taskbar and the
application can be restored by double-clicking the notification icon or via the menu.
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Menubar

Most of the menu items are directly accessible through shortcuts.
Also, as with any Windows application, menu items are accessible by the keyboard after pressing the Alt key.
The menubar contains the following elements:

= the File menu:

& SID Monitor

Itis used for exiting the application (ﬂ ).
Note: one can also use the notification icon .

= the View menu:

& SID Monitor
File

Date

Channels
GOES
Graph
Qutput

] [5] S = &

It is used for showing the various tabs.

= the Data menu:

&p SID Monitor
File View | Data | Graph Reports Tools Help

Acguisition (Mow running: 2s) Ctrl+Shift+a

3.0 ¥} | ResetDetection Algorithm

| Reapply Algorithm Parameters

It is used for:
o starting or stopping the signal level sampling.
Note: this can also be done through the status bar or the notification icon .

o 7 resetting the history values of the aberrant behavior detection algorithm. This asks the algorithm to forget what it



has learnt so far.
Note: This may be useful after a change in the tuning parameters or if the algorithm is "diverging".
o & reapplying to the existing data new parameters of the aberrant behavior detection algorithm .
Note: This may be useful if one wants to process the existing database with a new set of parameters.
This operation is very demanding in terms of memory (1Gb of RAM is welcome) and of processing time (expect a
few tens of minutes to a few hours, depending on the database size.)

m the Graph menu:

&p SID Monitor
File View Data | Graph | Reports Tools Help

Graph Update (Mow stopped) Ctrl+5hift+G
i.o = | Update Mow Ctrl+l
|ml Save Graph as PNG Ctrl45
It is used for:

o starting or stopping the automatic update of the graph display .
Note: one can also use the status bar or the notification icon .

o B asking for an immediate refresh of the graph with up-to-date values.
Note: one can also use the graph contextual menu , the date tab , the channels tab or the GOES tab .

o = Save current graph as a PNG file.
Icon is grayed out if no image is displayed.
Note: one can also use the graph contextual menu .

= the Reports menu:

&p SID Monitor
File View Data Graph | Reports | Tools Help

Generate Report Cirl+R
[Z)| View Existing Report  Ctrl+5hift+R

[ml save LogFile Ctrl45hift+5

It is used for:
o generating a report . This is normally to be done on a monthly basis.

o |Zl viewing existing report : list of events with their characteristics and the associated graphs.
o =l saving as an RTF file the messages logged in the message window .
Note: one can also use the message window contextual menu.

= the Tools menu:



File View Data Graph Reports | Tools | Help

e Sunrise and Sunset Times. .. Ctrl+T
e Minimize To Tray
[0 Options... Ctrl+0

Itis used for:
o e accessing the sunrise and sunset times calculator .

o The "Minimise To Tray" checkbox asks to minimize the application to the system tray only. If set, no SID Monitor
tab if present in the Windows taskbar when the application is minimized.
Note: one can also use the Options/Startup panel.

o [3+ setting application options .

» the Help menu:

Help

¥ Contents Cirl4+F1
& Index

43  Search

{6

L

Chedk for Updates

About...

Itis used for:
o @& # accessing this help information.
o checking for application updates.
Note: this option is enabled only for an online installation. Please refer to Installation for more information.
o L opening the "About..." information box .
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Graph area

Plots are periodically generated if the graph automatic update is enable, either in the graph menu , the status bar or the
notification icon .

Plot content can be adjusted through the date tab , the channels tab and the GOES tab .

Many parameters, such as line colors and refresh period, are defined in the options menu .

Mouse graph interaction

Zoom

Zoom in and zoom out capabilities are available through the mouse wheel.

Zooming in and out is limited to a factor of about 6 times.

The zoom ratio is shown (if different from 1.0) in the bottom-right of the viewing area.

When the plot size fits entirely in the viewing area, it is not possible to zoom out any further.

Pan

If the plot size exceeds the viewing area, the cursor changes to a hand (+ ). It is then possible to pan the graph in any
direction by moving the mouse with the left button pressed.

When the plot size fits entirely in the viewing area, the cursor has a cross shape (+).

Graph contextual menu

Right-clicking in the graph area opens a contextual menu. This menu allows to:

| ZoomIn

W1 Zoom 1:1

Increase Image Size
Decrease Image Size

Default Image Size

Update Mow Ctrl+l

B o & [ [

Save Graph as PNG Ctrl+5

1 1 1 1 1 1
04:00 G06: 00 0E:00 la: 0o 12:00 L4:00

= Zoom in/out the image without modifying the image resolution:
zoom in,
E Zoom out,

reset zoom factor to 1.0.
Icons are grayed out if a zoom factor limit is exceeded.

= Change the image resolution:
[=] increase image size,



(=] decrease image size,
& revert to default size.

Image resolution can be scaled up or down by a factor of about 4.
Icons are grayed out if an image size limit is exceeded.

B Updates the graph image.

» =l Save current graph as a PNG file.
Icon is grayed out if no image is displayed.
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This tab selects the time range of the graph displayed in the graph area .
Four options are available:

m "Today": the graph is plotted for the current day from 00h0O0 to 24h00.

m "Last 24 hours": the last 24 hours are plotted. The graph end to the current time.

m "Select date": a given day, or a range of days, can be selected from the calendar. Graph will be plotted from 00h0O of
the first selected day to 24h00 of the last selected day.

m "Select range": The "From" and "To" fields can be filled in to specify range of the graph plot. This is useful for zooming
in on a specific period of time for in-depth event analysis.

Missing data are indicated by red bands.

This tab allows to show an history of 1 month of measurements.



Note: All times and dates in SID Monitor are expressed in UTC. The application relies on Windows timezone setting for
the UTC time calculations.

The lower part of the tab contains the UTC time at which the graph currently displayed has been generated.
A button is available to refresh immediatly the graph.
Note: one can also use the Graph menu , the channels tab or the GOES tab .
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[E Channels Tab

[] Show Sun
[] Show Forecast

Displayed Channels Tootlll Level
DHO23 on23.4kHz  [187 (]

'“_r‘ Date I Channels ¥ coes
This tab selects the elements plotted in the graph displayed in the graph area .
The following options are available:

= "Show Sun" checkbox, to indicate whether or not sunrise/sunset and twilights times are displayed. Only the period of
time between the sunrise and the sunset patterns is usable for SID events detection.

= "Show Forecast" checkbox, to indicate whether or not aberrant behavior detection algorithm confidence bounds are
displayed. Detected failures (indicating a potential event, provided the algorithm is correctly tuned) are indicated by
vertical bands.

m "Displayed channels": the user can select which channels are displayed. Up to 16 ADC channels can be monitored.
The real time value of the signal level is also indicated. It is expressed in mV.

Missing data are indicated by red bands.



The lower part of the tab contains the UTC time at which the graph currently displayed has been generated.
A button is available to refresh immediatly the graph.
Note: one can also use the Graph menu , the date tab or the GOES tab .
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Ed GOES Tab

GOES 3 =
G0ES Solar X-Ray Flux Data

Show Primary GOES ¥-ray Flux
[] Show Secondary GOES ¥-ray Flux

Last GOES Update
@ 21 Feb 2011 19:00:00 UTC

é Update Now

& coes | T channels | Date

This tab selects the GOES data plotted in the graph displayed in the graph area .

GOES data are automatically downloaded from the internet. The values are provided by the Space Environment Center of
the National Oceanic & Atmospheric Administration (NOAA).
The values are stored in a specific database.

The plotted values correspond to the solar X-ray flux in the 1-8 Angstrom (0.1-0.8 nm) passband as measured by satellites
GOES satellites.

The X-ray flux is measured in W/mz2, The values are scaled to fit in the signal level plot.

= X-class flares: above 2.5V (>104 W/m2). They are major events that can trigger planet-wide radio blackouts and long-
lasting radiation storms.

= M-class flares: between 2V and 2.5V (10° to 10"* W/m?). They can cause brief radio blackouts that affect Earth's
polar regions.

» C-class flares: between 1.5V and 2V (1076 to 10> W/m?). They are small with few noticeable consequences here on
Earth.

= B-class flares: between 1V and 1.5V (1077 to 10°6 W/m?).
= A-class flares: below 1V (<107 W/m?)

Flares above M1 (1-10"° W/m2) should be detected by the monitoring station.

The following options are available:

m "Show Primary GOES X-ray flux" checkbox, to select display of data recorded by the Primary GOES satellite.

m "Show Secondary GOES X-ray flux" checkbox, to select display of data recorded by the Secondary GOES satellite.
The time of the last download of GOES data is indicated. It is possible to perform an immediate update of the information.



The lower part of the tab contains the UTC time at which the graph currently displayed has been generated.
A button is available to refresh immediatly the graph.
Note: one can also use the Graph menu , the date tab or the channels tab .
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Message Pane

The message pane logs information, warning and error messages provided by the application.

m information messages are in black. These messages are not shown if the "Verbose" option is not set (see
Tools/Options - Startup ).

® warning message are in . Warning message indicate a non-nominal behavior that has no effect or can be
recovered without user interaction.

m error messages are inred . Error messages indicate a serious problem that normally requires user interaction to be
solved. For instance, when the serial port is locked by another application.

Each message is logged with the corresponding UTC date and time.

05/09/2006 16:13:39: Updating Database... HO23 (9 values)

([

05/09/2006 16:13:59: Updating Database... HO23 (9 values)

05/09/2006 16:19:19: Updating Database... HO23 (10 values)
05/09/2006 16:19:39: Updating Database... HO23 (10 values)
05/09/2006 16:19:59: Updating Database... HO23 (10 values)
05/09/2006 16:20:19: Updating Database... HO23 (10 values)
lDE,."DQ,."EDDE 16:20:39: Updating Database... HOZ23 (10 values)

The here above message pane example shows information message logged every 20 sec. at each database update. It
contains the name of the datasets being updated ("HO23") and the number of elements (here, normally 10 per period,
meaning that the signal level is sampled with a 2 sec. resolution).

One warning message has been raised for ADC response timeout, corresponding to either a connection problem with the
ADC converter or a CPU limitation (another process has consumed too much CPU and led SID monitor ADC watchdog
to raise a timeout). Consequently, the subsequent database update contains only 9 values.

A left click on the message pane raises the contextual menu.
lUpdating Database... HOZ3 (10 values)

Hggi:ﬂg gizgzz:: bd SavelogasRTFFile  Cirl+Shift+S
lUpdating Database... HUZI T values)
It allows to save all logged messages as a RTF file.

Note: one can also use the Reports menu .
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Main Window Status Bar

The Status Bar contains:
= on the left-hand side, the database filename currently used by the application for storing signal level data.

= on the right-hand side, two lights named "ADC" and "Graph", indicating respectively the status of the signal sampling
and the status of the graph display automatic update.

Double-clicking on a light toggles its state.
Note: one can also use the Data menu /Graph menu or the notification icon contextual menu.

Green light (@) indicates that the ADC/graph timer is active. Yellow light (&) indicates that the timer is stopped.

I Database: D:Yionel\Mes documentsVisual Studio 2005'ProjectsSID monitor\SID monitor {bin'Release\data'sid.rrd Q aDC & Graph I
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™ Notification Icon

A notification icon is present in the system tray of the windows taskbar (notification area).

L
% 1, 17:39
l“)I -
A double-click on the icon hides or restores the application main window.

If the "Minimize to Tray" option is set, when SID Monitor is minimized, no tab is present in the taskbar to save space.

The notification icon is in color ( ™ ) when the data sampling is running and in grey (Lﬂ ) when the data sampling is
stopped.

A right-click on the icon raises a contextual menu that allows:

Acguisition (Mow running: 2s)
Graph Update (Mow stopped)

Exit

Restore SID Monitor Window

W jiso 17:14
¥

m starting or stopping the signal level sampling.
Note: one can also use the status bar or the Data menu .

m starting or stopping the automatic update of the graph display.
Note: one can also use the status bar or the Graph menu .

» [ exiting the application.
Note: one can also use the File menu .

m restoring the application main window.
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C- Options

The options window is used to set application parameters.

nﬂ Data Acquisition
I Channels
%3 Databass
Holt-Winters Forecast
Graph
[ Report and Alert
% Location

= {} Startup for setting application startup parameters.
» B Data Acquisition for setting acquisition update period.
n .Channels for setting each channel characteristics.
= 'l Database for RRDTool program and database filenames.
= BB Forecast for parameters linked to the RRDTool aberrant behavior detection algorithm.
" Graph for graph general parameters.
= [=| Reports for reports and alerts settings.
= . Location for defining station location.
The options are stored on a per-user basis. Initial values are provided after application installation.
At application startup, if a parameter in invalid (e.g. wrong filename), the options window is automatically displayed.

Panels containing invalid values are highlighted in red. An icon () identifies which parameter is invalid and information
regarding the origin of the problem is provided.

Copyright (c) 2006-2011 Lionel Loudet
Home Page: http://sidstation.loudet.org/sidmonitor/
Support: lionel@loudet.org



S Monatboringe Starbior

@ Options Startup

-
M Options

i3 Startup Startup

"@ Data Acquisition [] Automatic start when user logs

! Channels [] Start minimized

% Database o

Holt-Winters Forecast e
Graph [] Verbose Messages Log
[ Report and Alert
2 Location

This panel is used to set the startup options of SID Monitor .

It is possible to automatically start SID Monitor when the user logs. This can be useful to ensure that data acquisition
continues when the computer reboots for any reason.

SID Monitor can be set to initially start minimized through the "Start Minimized" option.

The "Minimize to Tray" option allows to save some space on the Windows taskbar. If selected, only the notification icon is
visible in the system tray when the application is minimized.

The "Verbose" option indicates if recurrent messages are displayed in the message pane . When not enabled, only
warning/error or unusual messages are shown.

Copyright (c) 2006-2011 Lionel Loudet
Home Page: http://sidstation.loudet.org/sidmonitor/
Support: lionel@loudet.org



S Monatboringe Starbior

B Options Data Acquisition
FM Options E]@-\

€} Startup Diata Acquisition Parameters
uﬂ Data Acguisition
1 Channels
@ Database GOES Update (hours, 0 for no update): &
Holt-Winters Forecast
Graph [] Update also Secondary GOES
,_'] Feport and Alert
‘o Location

Channels Acquisition Update (seconds): |10

<l

<l

| 0K || Cancel

This panel is used:
m To set the acquisition update parameter that corresponds to the sampling period of the signal level. Minimum value is 2
sec.
m To set the period of the GOES data download, in hours between 1 and 24. Internet access is necessary to allow
GOES data update. Setting the parameter to 0 disable GOES data download.
m To enable/disable the downloading of the Secondary GOES data. Secondary data are not always available from the
Space Weather Prediction Center http://www.swpc.noaa.gov/
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M Options Channels

M Options g@
-:,i Startup Channels Parameters
o Data Acquisition Cﬁ@ Port Station Code Title ‘._'j Line Width and Color
# g;?:;:slz channel 1 CoM3 v HO22 none thin v [i]
Holt-Winters Forecast [] channel 2 -
Yy Graph
Hepport and Alert [] channel 3 -
-4 Location [ channel 4 -
[] channel 5 -
[] channel & -
[] channel 7 -
[] channel & -
[] channel 9 -
[] channel 10 -
[] channel 11 -
[] channel 12 -
[] channel 13 -
[] channel 14 -
[] channel 15 -
[] channel 16 -
GOES Parameters
Primary GOES  |GOES-15 Solar Xray Flue (0.1-0.8mm) in Vi/m? medum (| (I
] Secondary GOES |{none) medium v [E]
[ Ok || Cancel |

Up to 16 channels can be monitored by SID Monitor . This panel is used to select which channels are active.
Each channel has the following parameters:

m the port name used to access the ADC converter. This information is selectable from a list of ports available on the
computer.

m the station code of the VLF transmitter being monitored. This code consist of the final two letters of the station call sign
followed by the transmitter frequency rounded to the nearest integer. For instance, the station code of NAA on 24.0kHz
is AA24 and the station code of DHO on 23.4kHz is HO23. This code is used as a dataset name for the RRDTool
database.

= a short description of the channel being monitored. This is used as a legend for the graph.

» the line width and color of this channel on the graph.



This panel is also used to precise the color and the titles of the GOES plots. The titles are used as legend for the GOES
plots.
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& Options

-:,i Startup Databases Parameters
Data Acquisiti
D?ﬂ oh = quIs on RRDTool Program Filename:
annels

Ti C:M\Program Files"RRDToal'mdtool exe
ﬂ Holt-Winters Forecast [latabase History Folder:
Graph D:Mionel\Mes documentsiVisual Studio 2005\Projects’51D monitor'.510 monitorbin’ Release'\data Select

[£ Report and Alert

: Location

Channels Database Filename:
D:Mionel'Mes documentsWisual Studio 2005 Projects’SID monitor'.510 monitor'binReleasedata'sid.md Select...

GOES Database Filename:
D:Mionel'\Mes documentsVisual Studio 2005 Projects™SID menitor’.S10 monitor'bin® Releasedata‘\goes r Select...

This panel is used to set:
m The location of the RRDTool program. This program is used to store data and to generate graphs.
m The location of the history folder. Monthly backups of the databases are stored in the selected folder.
m The filename of the database used to store the signal level measurements.
= The filename of the database used to store the GOES X-ray flux data.
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& Options

£} Startup Holt-Wirters Forecasting Algorthm Parameters
o Data Acquistion Predicted Values:

1 Channels

1 Databass
ot Ve Fres]

Graph 0.50
[ Report and Alert P2

: Location

alpha: (010 | J

4

Seasonal Coefficients:

gamma: (010 |3 J

Seasonal Deviation Coefficients:

gamma: |0.10 |3 J

Aberrant Behaviour Flagging:

o
-

lower bound: [2 £ J upper bound: |2

e
<1

threshaold: |7

window length; |3 v

This panel is used to set all the parameters of the Holt-Winters aberrant behavior detection algorithm.
More information on the effect of the various parameters is available in the Forecast FAQ .
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Options Graph
& Options B@E|

-:,i Startup Graph Parameters
n@ Data Acquisition
i Channels Refresh Time (min):|1 E
%3 Databass Sun Options
£ Holt-Winters Forecast Civil Twilight Color:
S t-'
MNautical Twilight Color:
= Report and Alert
% | ocation Astronomical Twilight Color
Night Calar: E
Forecast Options
Failures Calor:
1-g Shading Value: 070 % J
2-g Shading Value: 080 3 J
3o Shading Value: 050 % J

Color Example: Line 1-a 2-a 3o

This panel sets the periodicity of the graph update. Automatic update of the graph is enabled or disable through the Graph
menu , the status bar or the notification icon contextual menu .

Sun Options

It is also used to choose the colors for the twilight and night bands that are displayed on the plot. They can be used to
correlate signal level sunrise and sunset patterns with actual sunrise and sunset times. The channels pane is used to
enable the display of the bands.

Forecast Options

Parameters for the display of forecast algorithm results are available in this panel.
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The color of the failure marks can be choosen. These marks indicate when the algorithm has detected an aberrant
behavior.

The color of the confidence bands calculated by the forecast algorithm can also be selected. The color is obtained by a
lightening of the corresponding channel line color. Each band (1 s, 2 s, 3 s) has its own fading parameter. The effect of
the color fading can be previewed for a selectable color.

The channels pane is used to enable the display of the failure marks and of the confidence bands.
More information on the forecast algorithm can be found here .

Copyright (c) 2006-2011 Lionel Loudet
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= Options Report and Alert

g Startup Report and Alert Parameters

nﬂ Data Acquisition

1 Channels ngsewer Code: (A—

%3 Databass

ﬂ Holt-Winters Forecast

Graph o

= E::_\),. [] Send mail upon unexpected behaviour detection

: Location
Send Mail From:
Send Mail Tao:
SMTP server or IP address:
SMTP server port:

Q, The observer ID provided by the AAVSO must be set here so that it is correctly included in the reports generated by
the application.

ﬁrﬁ SID Monitor offers the possibility to send daily or hourly mail alerts when an SID event has been detected by the

aberrant behavior detection algorithm. Optionnaly, the graph can be attached to the mail.
Itis necessary to precise:
m The mail sender address in the "From" field.
m The mail receiver address in the "To" field.
m The SMTP server to use for mail transfer (either fully-qualified server name or IP address)
m The SMTP server port. Default is 25.

Copyright (c) 2006-2011 Lionel Loudet
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(L Options Location

a Startup Station Location

nﬂ Data Acquisition . Latitude (degrees minutes seconds)
I Channels * B gz 3k g
%3 Databass

ﬂ Holt-Winters Forecast Longitude (degrees minutes seconds)
e | e

] oo

This panel is used to set latitude and longitude of station location. This information is used for sunrise, sunset and twilights
time calculation. The sun position is stored in the database. SID events can only be detected during the day-time period.

Copyright (c) 2006-2011 Lionel Loudet
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@ Reapply Algorithm Parameters

The "Reapply Algorithm Parameters" toolbox allows to force re-execution of the Holt-Winters aberrant behavior detection
algorithm with a new set of parameters to the whole content of a database.

1 Note that this operation is very demanding in terms of memory (1Gb of RAM is welcome) and of processing time
(expect a few tens of minutes to a few hours, depending on the database size...)

The Database to process is by default the current database. Other databases can be selected by entering their neame in
the "Database" field or by the "Select..." button.

The new set of parameters can then be selected by the sliders. More information on the effect of the various parameters is
available in the Forecast FAQ .

When all parameters are set, press the "Ok" button to start the processing. The operation can be cancelled any time.

A copy of the initial database will be created with the extension .ol d.rrd .



Reapply Algorithm Parameters

&

Databasze: |D:‘Jinne|\|'l-l'|es documents*Visual Studio 20054 Projects*510 monitor* 510 monitortbinRele |

| Select... |

Holt-Winters Forecasting Algorithm Parameters

Predicted Values:

-
alpha: (010 ] ,“) s

-

beta: (0.50 |& .. . . . . . .

Seasonal Coefficients:

—
gamma: (0.10 |3 N
Seasonal Deviation Coefficients:
—
gamma: 010 % W

Aberrant Behaviour Flagging:

lower bound: |2 S _J upper bound: |2 S _J

. !
threshold: |7 & g

| ok || Cancel

Copyright (c) 2006-2011 Lionel Loudet
Home Page: http://sidstation.loudet.org/sidmonitor/
Support: lionel@loudet.org




oSl Moniatbtoringe Starbtion.

= Generate Report

The report must follow a format prescribed by the NGDC and the AAVSO .
Note that one report must be generated for each station code. Take care to follow the naming conventions.

Here is an example of report file:

AAVSO Sudden | onospheric Di sturbance Report
Qbserver: A---
Station: HO23
Dat abase: sid. 0406.rrd
GCES Dat abase: goes. 0406.rrd

Date: 04/06

40 060405 1306 1430U1409 2+ 5HO23 A---
40 060405 1518 1650U1521 3 5HO23 A---
-- end report --

SID Monitor provides help in reducing the data and generating a correct report format.
The Generate Report toolbox is opened through the Reports/Generate Report menu.



Generate NGCD Report EI

Fle  View Edit Help
Report a3 x
() Select Report Month: |— | Year: |:IIE~ |
(%) Select Existing Report: |D:\,|ione|\,'\"|es documentsVisual Studio 2005'Projects\SID monitor \SID monitor\pin'\Release\data\0406\A—-DHO. . dat | [ Select... ]
() Select Database File: |Z‘: onel\Mes documentsVisual Studio 2005'Projects\SID monitor{SID monitor\bin'\Release\datal0406 \sid. 0406.rrd | Select
GOES database: | D:\lionel\Mes documents\Visual Studio 2005\Projects\SID monitor\SID monitor\bin\Release\data\0406\goes.0406.rrd
Day: EI Channel: Show Sun  [] Show Forecast [ ] Show GOES10 [] Show GOES11  [] Show GOES12
Events a x
Date Start | Start Qualifier End End Quialifier Max | Max Qualifier Importance Definiteness Station Observer
»
mer., 05 avr. 06 15:18 |MNone 16:50 | Uncertain (1) 15:21 | MNone 3 (B6-125mn) 5 {Definite) HOZ23 A
E Graph 4 b =
o ~

1.0

Output a

07/12/2006 19:37:07: Reading database file "D:Vionel\Mes documents!yisual Studio 2005'Projects\SID meonitor\SID monitor\bin'\Release\data 0406 sid, 0406.rrd™
07/12/2006 19:37:07: Updating graph...

07/12/2006 19:37:07: Updating graph...

07/12/2006 19:37:07: Updating graph...

07/12/2006 19:37:07: Found 2 events in report "D:Yionel\Mes documents \Visual Studio 2005'Projects\SID monitor\SID monitor bin'Release \data 0406 \a-—DHO. dat™
07/12/2006 19:37:18: Updating graph...

07/12/2006 19:40:00: Updating graph...

B3 B S

=

Report Selection

The user has the possibility to:

m generate a report for a given date, by filling in "Month" and "Year" fields. This is the most straightforward means to use
that toolbox.

m update an existing report.

m select a specific database.

When a date is being selected, the database and GOES filenames are searched in the current folder is the report is for the
current month, or in the history folder that corresponds to the selected month.
When a database file is choosen, the program determines the date and searches for an associated GOES database file.

The corresponding graph can then be displayed in the graph area.

It is possible to select a the graph day and the channels to display. The options "Show Sun”, "Show Forecast”, "Show
Primary GOES" and "Show Secondary GOES" are available and have the same affect as in the main window graph
area.The graph area offers the same functionalities (zoom and pan) as the main window graph area.

When an existing report file is selected, the events contained in the report file are displayed in the Events table.



If the associated channels and GOES database are present in the same directory as the selected report, they are
indicated in the "Channels database" and "GOES database" fields.
The databases are searched in the following locations:
m first from the "Database:" and the "GOES Database" fields of the header of the report file;
m then from the filenames si d. MWY. rrd and goes. MWY. rrd , where Mvand YY are respectively the month and the year
of the report;
m finally from the filenames si d. rrd and goes. rrd .

The Output pane displays specific messages indicating the status of the operations.

Events Modification

A contextual menu allows to add, edit or delete events from the table. The same operations can be done through the
"File/Edit" Menu .

Importance Definiteness
I || AddEvent
|| EditEvent
%|| Delete Event(s)

Selecting "Add Event" (gl) opens a windows to fill in the SID event information. More information on the format of the
report file and on the definition on the fields is available in the Reports FAQ .

Selecting "Edit Event" (ﬂ) opens a windows to fill in the SID event information.

Selecting "Delete Event" (ﬁl) deletes the events currently selected in the table.

Menubar

The menubar contains the following elements:
m the File menu:

Generate NGCD Report
Edit Help
Lﬁ Open Database Ctrl+0
Lﬁ Open Report

A
Save Empty Reports

E] Exit

It is used for:
o & loading a database file.
Note: one can also use the "Select..." button from the Report pane.

¢ ﬁloading a report file.
Note: one can also use the "Select..." button from the Report pane.

o |=l saving report files.



o saving empty report files.
Note: this allows to create empty report files for station code that do not have events to save.

¢ closing the "Generate Report" toolbox.

= the View menu:

Generate NGCD Report

It is used for showing the various tabs.
u
» the Edit menu:

Generate NGCD Report

|| AddEvent
J)| EditEvent
%|| Delete Event(s)

It is used for adding (ﬂ), editing (ﬂ) and deleting (51) SID events from the Events pane.
Note: one can also use the contextual menu of the Events pane.

u
= the Help menu:
Generate NGCD Report

Contents

Index

Search

It is used for accessing this help information (@ € &3).

Copyright (c) 2006-2011 Lionel Loudet
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View Report

The View Report toolbox is opened through the "Reports/View Existing Report" menu.

View NGDC Report [
file  View Help
Report 1
Report filename: |D:‘~Jione|‘~|l'~‘les documentsVisual Studio 2005\Projects\SID monitor\SID monitor bin'Release\data\0406'A-—DHO. dat | [ Select... ]
Channels database: | D:\lionel\Mes documents\Visual Studio 2005\Projects\SID monitor\SID monitor\bin\Release\data\0406\sid.0406.rrd
GOES database: D:\lionel\Mes documents\Wisual Studio 2005\Projects\SID manitor\SID maonitor\bin\Release\data\04064goes.0406.rrd
Show Sun [] Show Forecast ] Show GOES10 [ show GoES12
Events o %
a Start | Start Qualifier End Qualifier Max | Max Qualifier Importance Definiteness Station Observer
mer., 05 avr. 06 15:18 | None 16:50 | Uncertain (U) 15:21 | None 3 (86-125mn) 5 (Definite) HO23
Graph b ox
S o2 A
=
m
I
&
-
v
L.6
o.n B
0G: 00 02:00 04: 00 06:00 08:00 1a:00 L2:00 l4:00 L6:00 L3:00 i
Qutput _
07/12(2006 19:42:57: Reading report file "D:Yionel\Mes documents\Visual Studio 2005'Projects\SID monitor\SID monitor\hin'Release \data\0406\A—DHO. dat”
07/122006 19:42:57: Found 2 events in report "D:YionelMes documentsVisual Studio 2005'\Projects'SID monitor\SID monitor \hin'\Release \data\0406\A-—DHO. dat”™

Report Selection

The report file selected in the "Report filename" field is processed. By default, report file extension is expected to be . dat .

The events listed contained in the report file are displayed in the Events table.
More information on the format of the report file and on the definition on the fields is available in the Reports FAQ .

If the associated channels and GOES database are present in the same directory as the selected report, they are
indicated in the "Channels database" and "GOES database" fields.
The databases are searched in the following locations:

m first from the "Database:" and the "GOES Database" fields of the header of the report file;



m then from the filenames si d. MWY. rrd and goes. MWY. rrd , where MMand YY are respectively the month and the year

of the report;
m finally from the filenames sid.rrd and goes. rrd .
If those filenames are found, the graph area is used to display the graph of the day that corresponds to an event selected

from the table.
Options "Show Sun", "Show Forecast", "Show Primary GOES" and "Show Secondary GOES" are available and have the

same affect as in the main window graph area.
The graph area offers the same functionalities (zoom and pan) as the main window graph area.

The Output pane displays specific messages indicating the status of the operations.

Menubar

The menubar contains the following elements:
m the File menu:

View NGDC Report

It is used for:
o lffloading a report file.
Note: one can also use the "Select..." button from the Report pane.

o closing the "View Report" toolbox.

| ]
= the View menu:
View NGDC Report

It is used for showing the various tabs.

u
» the Help menu:

View NGDC Report

Help
¥ Contents

& Index

34 Search




It is used for accessing this help information (@ € 33),

Copyright (c) 2006-2011 Lionel Loudet
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s Sunrise and Sunset times calculator

This utility indicates for a given day the sunrise, sunset and twilight times.

The civil twilight correspond to a sun position between 0 and -6° below the horizon.

The nautical twilight correspond to a sun position between -6° and -12° below the horizon.

The astronomical twilight correspond to a sun position between -12° and -18° below the horizon.
The noon time correspond to the highest sun altitude.

Calculations are done for the location provided in the options / location panel .

Sunrise And Sunset Times Calculator [

Date: lundi mai 2006 b

Location: [N43°27 31" E1° 19 47

Times expressed in UTC:
Morning Astronomical Twilight: [03:.02 UT

Marning Mautical Twilight: 0343 UT

Marning Civil Twilight: 0421 UT

Sunrise:; 04:52 UT Min Sun Alt:  |-32.34°
Moon Time: 11:53UT Max Sun Alt: |61.66°
Sunset: 1852 UT  Day Length:  |14:00
Ewvening Civil Twilight: 19:23UT

Evening Nautical Twilight: 2000 UT

Evening Astronomical Twilight: | 20:42 UT

The sunrise and sunset times are precise to a few minutes which is sufficient for our purpose.

Copyright (c) 2006-2011 Lionel Loudet
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L About information box

This box indicates program version, author's contact and web site link , as well as licence information.

m About ﬁ

SID Monidtboring Statiore

Ltility for SID Monitoring Stations Wersion: 1.3.0.0

(c) 2005-2011 - Lionel Loudet
Author's Wweb Site

SID Monitor comes with ABSOLUTELY NO WARRANTY.

This is free software, and you are welcome to redistribute it
under certain conditions.

Faor details, refer to the GNL General Public Licence

Copyright (c) 2006-2011 Lionel Loudet
Home Page: http://sidstation.loudet.org/sidmonitor/
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@ FAQ

1. What are the rules for filling in correctly the monthly report?
2. How are defined the RRDTool databases?
3. What's the meaning of all of those "Forecast parameters"?

Copyright (c) 2006-2011 Lionel Loudet
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9 FAQ — Reports

The following elements are required when filling in the report. This section includes excerpts from the AAVSO
requirements for defining those parameters. For more information, refer to the AAVSO SID Program website.

[ l

L6:00 L7:00 LE: 00

Here is an example of SID event correlated to the GOES measurements:

The red and violet lines correspond to GOES-10 and GOES-12 measurements of the x-ray flux.
The green line correspond to the signal level measurement with the confidence bands of the forecast algorithm.

Event Start : The moment when an event begins. Be aware that the amplitude of different events varies considerably, and
some may appear in inverted form. If it is obvious that an event began before the first definable start time, an 'E' (before) is



appended to the recorded time.

Event End : Of the three times, the end time is the most difficult to determine. It is defined as the moment when the trace
returns to the diurnal trend line, or is interrupted by the onset of a new event. In the latter situation, the letter 'D' (after) is
appended to that time, which in turn becomes the start time for the following event.

Event Maximum : The moment when the ascending (descending in the case of inverted events) branch slows its sharp
rise. Note that this generally does not coincide with the event's peak amplitude.

If the trace goes off-scale as maximum is approached, or is interfered with in some other manner such as the onset of
sunset, device failure, etc., we append a 'U' (uncertain) to the last identifiable time. For example, if the SID maximum
occurs somewhere off-scale and the last determinable time is fourteen hours, ten minutes (1410), the time is recorded as
1410U.

Importance generally refers to the length of an event, found by subtracting the start time from the end time. The table at
right associates the Importance rating with event duration.

With respect to the observer's typical daily trace, a class 1 SID is an event with small intensity change and a relatively short
duration. Class 2 is a moderate intensity event with a fairly long duration, and a class 3 describes a SID with a 'great’
change inintensity and long duration.

<19 min

1-

19-25

1

26-32

1+

33-45

2

46-85

2+

86-125

3

> 125

3+

LDmauan_l_Mpmanw_‘

Definitiveness or Definition is a subjective estimate of an observer's confidence in the event. Normally, the events which
are included in our reports have Definitions equal to 3 or greater. Use the right-hand scale as a guide to Definition. Careful
study and experience teaches observers how to recognize false SID events caused by man-made interference. Beginners
should not hesitate to assign high Definition values to those events which are not correlated with known noise sources.
Other observers' results will be compared to eliminate suspect events before a final report is submitted to the NGDC.
Questionable

0

Possible

1

Fair

2

Reasonable
3




Reasonably
Definite

4

Definite

5

Note that the filename must respect the AAVSO requirements which are recalled here:
Data files must be named according to the observer and the station monitored.

Each observer has an ID code. i.e. A87

Each observer monitors a VLF station with a 3 letter call sign. i.e. NAA

The file name should reflect these two pieces of information: A87NAA.dat

Copyright (c) 2006-2011 Lionel Loudet
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@ FAQ — Databases

SID Monitor uses RRDTool for the management of the databases. This tool handles databases according to the "round
robin" scheme. They have predefined fixed sizes, and the newer values are overwritten over the oldest ones.
This FAQ assumes the reader has a good knowledge of RRDTool commands.

Channels Database

Contents

The Channels database stores all channels signal levels. It has a capacity of 31 days. One dataset named sun is defined to
store the sun position with an update period of 1 minute.

Each channel has its own dataset. Nominal refresh period of the signal level is set in the Data Acquisition panel.

Example
Here is an example of creation of the Channels database.

rrdtool create "D:\...\sid-test.rrd"
--start 1147361783 --step 10

DS: sun: GAUGE: 120: 0: 8

DS: t est : GAUGE: 20: 0: 4096

RRA: AVERAGE: 0. 99: 1: 267840

RRA: HWPREDI CT: 267840: 0. 50: 0. 50: 8640: 3
RRA: SEASONAL: 8640: 0. 50: 2

RRA: DEVSEASONAL: 8640: 0. 50: 2

RRA: DEVPREDI CT: 267840: 4

RRA: FAI LURES: 267840: 7: 9: 4

Refresh period (step ) is set to 10 seconds. It corresponds to the sampling period of the signal level as defined in the
Options menu.

Two datasets are created, sun and t est with a GAUGE data type.

For the sun dataset, the heartbeat is set to 120 seconds, meaning that at least one value every two minutes is necessary,
otherwise the interval value will be set to Unknown. Nominal update is every minute. Minimum and Maximum values are
respectively setto 0 and 8.

For thetest dataset, the heartbeat is set to 20 seconds, meaning that at least one value out of two is necessary,
otherwise the interval value will be set to Unknown. Minimum and Maximum values are set to 0 and 4096, expressed in
mV.

The first archive stores actual values from the 'sun’ and the 'test' datasets. It has the AVERAGE consolidation function, with a
st ep parameter of 1, meaning that no average is done. The number of rows (267840) corresponds to the number of 10-
seconds intervals in 31 days... The xff parameter is set to 0.99, meaning that 99% of the data may be missing while still
validating a giveninterval.

The subsequent archives HWPREDI CT , SEASONAL , DEVSEASONAL , DEVPREDI CT and FAI LURES are related to the Holt-Winters
algorithm. "Alpha", "Beta", "Gamma seasonal" and "Gamma dev seasonal" parameters are set to 0.5. The seasonal
period (8640) corresponds to the number of 10-seconds intervals in one day. The window length (9) and the threshold (7)
have their default values.

GOES Database



Contents

The GOES database stores all GOES X-ray flux values downloaded from the internet. It has a capacity of 31 days.

It contains three datasets, goes10 , goes1l and goes12 , corresponding to each source of data. Nominal refresh interval is
1 minute.

Example

Here is an example of creation of the GOES database.

Refresh period (st ep ) is set to 60 seconds. It corresponds to the sampling interval of the X-ray flux data.

Two datasets are created, goesp (Primary GOES data) and goess (Secondary GOES data) with a GAUGE data type.
Heartbeat is set to 120 seconds, meaning that at least one value every two minutes is necessary, otherwise the interval
value will be set to Unknown. Minimum and Maximum values are not set.

Only one archive is defined. It has the AVERAGE consolidation function, with a st ep parameter of 1, meaning that no average
is done. The number of rows (44640) corresponds to the number of minutes in 31 days... The xff parameter is set to 0.99,
meaning that 99% of the data may be missing while still validating a given interval.

rrdtool create "D:\...\goes-test.rrd"

--start 1144683393 --step 60

DS: goesp: GAUGE: 120: U: U DS: goess: GAUCE: 120: U: U
RRA: AVERAGE: 0. 99: 1: 44640

Copyright (c) 2006-2011 Lionel Loudet
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@ FAQ — Forecast

RRDtool includes:

1. the Holt-Winters forecasting algorithm that is used to adaptely predict future values;

2. ameasure of the deviation between predicted and observed values, and definition of confidence bands;

3. aberrant behavior detection mechanism that flags observations that are too deviant from the predicted values.

Forecasting

The prediction is based on the Holt-Winters forecasting algorithm. It adaptively predicts future observations in a time
series.
This forecast is the sum of three components:

m a baseline (or intercept),

m alinear trend over time (or slope),

m a seasonal coefficient (a periodic effect, such as a daily cycle in our case).

There is one seasonal coefficient for each time point in the period (cycle). After a value is observed, each of these
components is updated via exponential smoothing. This means that the algorithm "learns" from past values and uses them
to predict the future.

The rate of adaptation is governed by 3 parameters:

m alpha: ais the adaption parameter of the intercept (or baseline) coefficient in the Holt-Winters forecasting algorithm. a
must lie between 0 and 1. A value closer to 1 means that more recent observations carry greater weight in predicting
the baseline component of the forecast. A value closer to 0 means that past history carries greater weight in predicting
the baseline component.

m beta: [ is the adaption parameter of the slope (or linear trend) coefficient in the Holt-Winters forecasting algorithm. 3
must lie between 0 and 1 and plays the same role as a with respect to the predicted linear trend.

m gamma seasonal : is the adaption parameter of the seasonal coefficients in the Holt-Winters forecasting algorithm.
It must lie between 0 and 1. Note that because there is one seasonal coefficient for each time point during the
seasonal cycle, the adaptation rate is much slower than the baseline. Each seasonal coefficient is only updated (or
adapts) when the observed value occurs at the offset in the seasonal cycle corresponding to that coefficient.

The closer the parameters are from 1, the faster the algorithm adapts.

Confidence Bands

The measure of deviation is a seasonal weighted absolute deviation. The term "seasonal" means deviation is measured



separately for each time point in the seasonal cycle. As with Holt-Winters forecasting, deviation is predicted using the
measure computed from past values (but only at that point in the seasonal cycle). After the value is observed, the
algorithm learns from the observed value via exponential smoothing. Confidence bands for the observed time series are
generated by scaling the sequence of predicted deviation values.

gamma seasonal deviation is the adaption parameter in the exponential smoothing update of the seasonal deviations. It

must lie between 0 and 1. The closer it is from 1, the faster the algorithm adapts. Note that because there is one seasonal
deviation for each time point during the seasonal cycle, the adaptation rate is much slower than the baseline.

Aberrant-behavior detection

:Jrll"\

i Jk e

LG:00 LE:00

Aberrant-behavior (a potential SID event) is reported whenever the number of violations (observations that fall outside the
confidence bands) exceeds a specified threshold within a specified moving temporal window.

The following parameters affect the detection mechanism:

m upper bound ordeltapos : d+ alters the deviation scaling factor for the upper bound of the confidence band used
internally to detect a violations. The default value is 2.

m lower bound or deltaneg : d_ alters the deviation scaling factor for the lower bound of the confidence band used
internally to detect a violations. The default value is 2.

m threshold is the minimum number of violations (observed values outside the confidence bounds) within a window that
constitutes a failure. The default value is 7.

m window length is the number of time points in the window. Specify an integer greater than or equal to the threshold

and less than or equal to 28. The time interval this window represents depends on the acquisition update time. The
default value is 9.

Note: This information is based on RRDTool documentation and on the paper "Aberrant Behavior Detection in Time Series
for Network Monitoring” by Jake D. Brutlag, Proceedings of the 14 Systems Administration Conference (LISA 2000),
New Orleans, Louisiana, USA, December 3-8, 2000.
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SID monitor source files are freely available on the author website.
Nothing made by a human can reach perfection. This software has necessarily shortcomings and bugs. The author
welcomes any feedback, comment or suggestion on SID Monitor , provided they help improving it.

Licence

Copyright (c) 2006-2011 - Lionel Loudet.

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General Public License
as published by the Free Software Foundation, at version 2 of the License.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the implied
warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public Licence
for more details.

You should have received a copy of the GNU General Public License along with this program; if not, write to the Free
Software Foundation, Inc., 51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA.
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